Command line tools

aaaaaaaaa
set
event -
an ex g datas
EEEEE -~ |data" {new)
Load existing dataset isting dataset" (old) . .
e i s RNSSER U Menus write both dataset and global histo
Save current dataset as | jnfo" (continuous data)
lear dataset(s) "(add/edit dataset info)
. (sa taset)
Sele al
oad Iy > Reject continuous
ave ¢ epochs”
Save ¢ emo
CCCCCCCCCC
Memory options
Save history
Quit

« Automated processing on groups of subjects
(possibly on several processors).

* Richer options for plotting and processing
functions (time-frequency decompositions, ...)

« Selecting data/epoch based on event context

« Custom processing...



Starting EEGLAB

EEGLAB v4.6b

File

Help

>> eeglab

eeglab: options file is /Volumes/donnees/data/STUDY ste
Adding path to all EEGLAB functions

Adding path to eeglab/external/bioelectromagnetism_ligt
Adding path to eeglab/external/biosig-partial

Adding path to eeglab/external/fieldtrip-partial

Adding path to eeglab/external/fieldtrip-partial subfolders

EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:
EEGLAB:

EEGLAB:
>>

adding plugin function "eegplugin_VisEd"

adding "eepimport1.02" plugin (see >> help ee
adding "bdfimport" plugin (see >> help eegplu
adding "brainmovie0.1b" plugin (see >> help €
adding "ctfimport1.03" plugin (see >> help ee¢
adding "dipfit2.2" plugin (see >> help eegplugi

adding "EEG toolbox ERP plotting" plugin (see >> help eegplugin_eeg_toolbox)
adding "erpssimport1.00" plugin (see >> help eegplugin_erpssimport)

adding "fmrib1.21" plugin (see >> help eegplugin_fmrib)

adding "iirfilt1.01" plugin (see >> help eegplugin_iirfilt)

adding "eepimport1.02" plugin (see >> help eegplugin_ascinstep)

adding "loreta1.0" plugin (see >> help eegplugin_loreta)

adding "Butter1.0" plugin (see >> help eegplugin_ ERPLAB filters)

adding "Measure Product1.0" plugin (see >> help eegplugin_mp_clustering)

adding plugin function "eegplugin_miclust"

adding "4dneuroimaging1.00" plugin (see >> help eegplugin_4dneuroimaging)

No current dataset

- Create a new or load an existing dataset:
Use "File = Import data" (new)
Or "File > Load existing dataset" (old)
- If new,
"File = Import epoch info" (data epochs) else
"File = Import event info" (continuous data)
"Edit = Dataset info" (add/edit dataset info)
"File > Save dataset" (save dataset)
- Prune data: "Edit > Select data"
- Reject data: "Tools > Reject continuous data"
- Epoch data: "Tools = Extract epochs"
- Remove baseline: "Tools = Remove baseling"
- Run ICA: "Tools = Run ICA"




eepimport1.02
bva_i01.30
ctfimport1.01

dipfit2.0
fmrib1.2b
Iirfilt1.0
loreta2.0

Proper EEGLAB plugins

Data importing for EEprobe data (Oostenved & ANT company)
Brain vision analyzer import/export plugin (Widmann & Delorme)
MEG CTF import plugin (Carver, Weber & Delorme)

4-shell and BEM (Oostenveld & Delorme)

Removal of artifact from simultaneously EEG/fMRI recording (Niazi)
Non-linear IIR filtering (Pozdin)

Interface to LORETA-KEY (Delorme)

Matlab toolboxes interfaced as plugins

BIOSIG
File-1O
Fieldtrip
LIMO-EEG
SIFT

Data importing for rare data binary format (Schloegl)

Data importing (Oostenveld)

Source localization and time-freq. decompositions (Oostenveld)
General linear model and EEG

Source information flow toolbox
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Plugin list process - SCCN

Ll

Plugin list process - SCCN

@) @ scen.ucsd.edu/wiki/Plugin_list_process (& | ’/g' Google Q\‘.‘ @ @
5] Google °* Google maps | Unittesting  Pluginlist { :PIPS [ : Amadeus EEGLABrev. . Bugzilla & Pubmed Aspet News/Nerd » [EJ Bookmarks ~
2 92.149.236.22 talk for this ip address log in
page discussion view source history

\

Swartz

Center for

Computational
Neuroscience

home

SCCN web site
EEGLAB Wiki
MoBI Lab Wiki
SCCN Wiki Home

eeglab wiki pages

EEGLAB web page
EEGLAB Wiki
EEGLAB Tutorial
Online EEGLAB
Workshop
Download EEGLAB
Revision history
Help EEGLAB

scen toolboxes

EEGLAB
NFT
BCILAB
SIFT
MoBILAB
MPT

wiki tools

Sandbox

Basic Wiki Syntax
Wiki Help

New Users

Plugin list process

Plugin name 4
brainmovie
corrmap
eeg_toolbox
ERPLABfilters
fMRIb
MP_clustering
MutuallnfoClustering
StudyEnvtopo
VisEd
ADJUST
iirfilt
loreta

BERGEN g/

Version 2

0.1

1.03

1.0

1.00

1.21

1.00

1.00

0.9

1.04

1.21

1.02

1.0
1.1

Interface EEG toolbox functions for ERP peak detection

Interface ERPLAB filters (requires seperate ERPLAB instalation)

Add your plugin to the list

Short plugin description

Brainmovies (command line only)

Import BIOPAC data files

Remove fMRI artifacts from EEG

Measure projection clustering of ICA components

Mutual information clustering

Add envtopo capabilities to STUDY

Add/Edit dataset events
Automatic artifact rejection

Non linear filtering

Export and import data to/from LORETA software

Link 4 Comments $
Download @ | User comments
Download g | User comments
Download g | User comments
Download g | User comments
Download @’ | User comments
Download @ | User comments
Download g’ | User comments
Download g’ | User comments
Download @ | User comments
Download | User comments
Download g | User comments

Download @ | User comments

Removal of fMRI-related gradient artifacts from simultaneous EEG-fMRI data Download @&’ | User comments

You may add your plugin to the list so users can download it automatically from within EEGLAB. There are 5 tabs:

= Plugin name: this tab should contain the abbreviated name of your plugin and if necessary a link to the plugin
documentation. The plugin documentation may be stored on this wiki.
= Version: this tab should contain the version of your plugin. The version listed on this page and the one made available in
the eegplugin_xxx.m file must be consistent. This allows EEGLAB to automatically check for newer versions of your

plugin.

= Short plugin description: this tab should contain a short plugin description (no more than one line). Additional
documentation may be provided as a link in tab 1.

@vx

S/e



Edit  Tools

Import data
Import epoch info
Import event info
Export

Plot Study Datasets Help

vyvvyvwvyy

Load existing dataset
Save current dataset(s)
Save current dataset as
Clear dataset(s)

Create study

Load existing study
Save current study
Save current study as
Clear study

Memory and other options

History scripts
Manage plugins

Manage data import plugins
Manage data processing plugins
Manage deactivated plugins




Writing EEGLAB plugins

« Assuming that you have a signal . Process any newtimef()
processing function called xxxxx Input data

« a pop_xxxxx function will I I
:cnter;‘_ace your signal processing . Process EEG bop. newtimef()
unction structure

* a eegplugin_xxxxx function will
add the menu to the main
interface (and history etc...)



Pop functions

Called with the EEG structure only pop xxxxx(EEG), they pop-up
a GUI asking for more arguments

Called with enough arguments, the simply call the signal
processing function

B Titte of wi... |- |03

function [EEG, com] = pop_sample( EEG, param1); Enter the parameter:
| 0

com ="; % empty history

if nargin < 2 ) ] Cancel| Help | 0Ok |
% pop up window if less than 2 arguments
result = inputdig({ 'Enter the parameter:'}, 'Title of window', 1, {'0'})

if length( result ) == 0 return; end;

param1 =eval(['[ result{1} '] ]1); % the brackets allow to process matlab arrays
end;

sample( EEG.data, param); % run sample function

com = sprintf('pop_sample(EEG, %d );', param1); % return history




EEGLAB Data Structures

EEG - root ‘dataset’ structure
.data - the dataset data (2-D, 3-D matrix)
.chanlocs - channel locations substructure
.event - data events substructure
.epoch - data epochs substructure
ALLEEG - vector of loaded EEG datasets

CURRENTSET - index in ALLEEG of current EEG dataset
STUDY - root ‘studyset’ structure

.Cluster - component clustering substructure



EEG structure

Number of data points
per trial

EEG= setname:'Epoched from "ee114 continuous
filename:'ee114squaresepochs

filepath:'fhomefarn Number of channels
pnts:384/
nbchan:32
trials: 50 <

srate: 128 ¢_ Number of trials
xmin -1

xmax:1.9922 — Sampling rate
data:[32x384x80 double]
icawinv:[32x32 double] . e
icasphere:[32x32 double] \ Time limits
]

icaweights:[32x32 double Data
icaact;[32x384x80 double]

event:[1:157 struct]

epoch:[1x80 struct] ICA scalp maps
chanlocs:[1x32 struct]
comments:[8x150 char]

avereriz'[rlwo' ICA activity
eventdescription:{1x5 cell}
epochdescription:{}
specdata:[] Epoch/event
speacaact:[l inf ti
reject:[1x1 struct] Information
stats:[1x1 struct]
splinefile:[]
ref'common’

history[7x138 char] Channel location
urevent:[ 1154 struct]
times:[1x384 double]




EEG =

The EEG
structure can
be extended

to include

new fields

store
information
for future
access

EEG structure

Number of data points

sethame:'Epoched from "ee114 continuous™ per trial

filename:'ee114squaresepochs sek

filepath:'fhomefarn Number of channels
pnts:384/

nbchan:32

trials: 50 < :
srate: 128 ¢_ Number of trials

xmin -1

xmax:1.9922 . Sampling rate
data:[32x384x80 double]
icawinv:[32x32 double] . e
icasphere:[32x32 double] \ Time limits
]

icaweights:[32x32 double Data
icaact;[32x384x80 double]

event:[1:157 struct]

epoch:[1x80 struct] ICA scalp maps
chanlocs:[1x32 struct]
comments:[8x150 char]

avereris'[rlwo' ICA activity
eventdescription:{1x5 cell}
epochdescription:{}
specdata:[] Epoch/event
speacaact:[] inf ti
reject:[1x1 struct] Information
stats:[1x1 struct]
splinefile:[]
ref'common’

history[7x138 char] Channel location
urevent:[ 1154 struct]
times:[1x384 double]




EEG.data =

Continuous data

(21 38 49 51 48 39

-13 -24 -05 -03 14 25 ..

052 47 33 1.2 07 1.3




Data epochs

(21 38 49 51 438

EEG.data =|-13 -24 -05 -03 14
|52 47 33 12 07

(2.1 38 49 51 438
-13 -24 -05 -03 14
| 52 47 33 1.2 07

(21 38 49 51 48
~13 -24 -05 -03 14
| 52 47 33 12 07

Plot ERP for your data

3.9
2.5
1.3

3.9
2.5
1.3

3.9
2.5
1.3

>> figure; plot(mean(EEG.data,3)’);
>> figure; plot(EEG.times, mean(EEG.data,3)');

Trials 1: EEG.data(:,:,1)

Trials 2: EEG.data(:,:,2)

Trials 3: EEG.data(:,:,3)



eegplugin functions

* eegplugin_erp.m function in “plugins” folder of EEGLAB

% eegplugin_erp() - plot ERP plugin
function eegplugin_erp( fig, try_strings, catch_strings)

% create menu
plotmenu = findobj(fig, 'tag’, 'plot’); % find plot menu

% create submenu
uimenu( plotmenu, ‘label’, 'ERP plugin’, ...
‘callback’, 'figure; plot(EEG.times, mean(EEG.data,3));");

To test, load file in sample data folder eeglab_data epochs ica.set



eegplugin functions

>> eeglab

eeglab: adding "BIOSIGv0.86" plugin

eeglab: adding "eepimport1.02" plugin (see >> help eegplugin_eepimport)
eeglab: adding "bva_io1.30" plugin (see >> help eegplugin_bva io)
eeglab: adding "ctfimport1.01" plugin (see >> help eegplugin_ctfimport)
eeglab: adding "dipfit2.0" plugin (see >> help eegplugin_dipfit2_0)

<gdlab: adding plugin function "eegplugin_erp” —>
eeglab: adding "“TmribT.Zb™ pIugin (see >> help eegplugin_fmrib)

eeglab: adding "icaclust1.00" plugin (see >> help eegplugin_icaclust)
eeglab: adding "iirfilt1.0" plugin (see >> help eegplugin_iirfilt)
eeglab: adding "loreta1.0" plugin (see >> help eegplugin_loreta)

eeglab: adding "newtimefreq1.00" plugin (see >> help eegplugin_ne

>> Figure No. 2

BE)X

File Edit Yiew Insert Tools Window Help

D& NA 2/ BRLD

EEGLAB v4.6b M= 25 : :
File Edit Tools Plot Datasets Help
Channel locations 4 L ) 20
#1: Ep Channel data (scroll) ontinuo...
Channel spectra and maps 151
Filename  Channel properties hsICA set
Channels  Channel ERP image 10k
Frames} Channel ERPs 4
Epochs ERP map series 4 51
Events SumfCompare ERPs . .
Sampling  component activations (scroll) 0 J R Nt
Epoch st Component spectra and maps ,'_1' i
Epoch er  Component maps » 5l
Average Component properties
Channel Component ERP image 10
ICA Weig Component ERPs 4
Dataset ¢ SumfCompare comp. ERPs / 15t
Data statistics » /
——————  Time-frequency transforms > // -_210000 _560 [I]

ERP plugin

1 1 1
500 1000 1500 2000




PCA plugin

function vers = eegplugin_pcaf(fig, trystrs, catchstrs)
vers = ‘pca1.00";

% find tools menu
menu = findobj(fig, 'tag’, ‘tools’);

% PCA command

cmd = [ ‘[~ EEG.icawinv] = runpca(EEG.data(:,:));" I;
cmd = [ cmd 'EEG.icaweights = pinv(EEG.icawinv);" ];
cmd = [ cmd 'EEG.icasphere = eye(EEG.nbchan);’ |;

% create menu
uimenu( menu, 'Label', ‘Run PCA', 'CallBack’, cmd, 'separator’, 'on');

'import data’ -> File > import data menu
'import epoch’ -> File > import epoch menu
'import event' -> File > import event menu
‘export’ -> File > export

‘tools’ -> tools menu

‘plot’ -> plot menu



EEGLAB documentation

EEGLAB Home Page sccn.ucsd.edu/eeglab/

EEGLAB Tutorial Index sccn.ucsd.edu/wiki/EEGLAB

- 200 pages of tutorial (including “how to” for plugins) WEB or PDF
- Function documentation (next slide)

- Send questions to the mailing list eeglablist@sccn.ucsd.edu
(or search mailing list archive using google)

- Bug submission htip://sccn.ucsd.edu/eeglab/bugzilla

- Email us (suggestions) eeglab@sccn.ucsd.edu

- Workshop with practicum every year


http://sccn.ucsd.edu/eeglab/
http://sccn.ucsd.edu/eeglab/eeglabtut.html
mailto:eeglablist@sccn.ucsd.edu
http://sccn.ucsd.edu/eeglab/bugzilla
mailto:eeglab@sccn.ucsd.edu

Help message

(v | Import dataset info\- pop_importdata()

atlab variable |8

Browse

Browse

Browse
Browse

fom 712

000 M-File Help: pop_importdata

File Edit View Go Debug Desktop Window Help

Y ‘ @ % 2 & M Location: [M—File Help: pop_importdata

>> help pop

M-File Help: pop_importdata

pop_importdata

pop_importdata() - import data from a Matlab variable or disk file by calling
importdata().

View code for pop_importdata

Usage:
>> EEGOUT = pop_importdata(); % pop-up a data entry window
>> EEGOUT = pop_importdata( 'key', val,...); % no pop-up window

Graphic interface (refer to a previous version of the GUI):

"Data file/array" - [Edit box] Data file or Matlab variable name to import
to EEGLAB. Command line equivalent: 'data’

"Data file/array" - [list box] select data format from listbox. If you
browse for a data file, the graphical interface might be
able to detect the file format from the file extension and
his list box accordingly. Note that you have to click on
the option to make it active. Command line equivalent is
'dataformat’

"Dataset name"” - [Edit box] Name for the new dataset.
In the last column of the graphic interface, the "EEG.setname"”
text indicates which field of the EEG structure this parameter
is corresponding to (in this case 'setname').
Command line equivalent: 'setname’.

"Data sampling rate” - [Edit box] In Hz. Command line eguivalent: 'srate'

"Time points per epoch" - [Edit box] Number of data frames (points) per epoch.

Default T

)ILL

>




Exercice

Write a plugin to plot ERPs

Save eegplugin_erp.m in the plugins
folder of EEGLAB

Restart EEGLAB
Load epoched EEGLAB dataset

Use plugin menu



Using EEGLAB history for basic scripting

Task 1

Create a script from ‘eegh’ output
Task 2

Adapt your script with variables
Task 3

Create a Matlab function
Task 4

Exercise...



Using EEGLAB history for basic scripting

Task 1

Create a script from ‘eegh’ output
Task 2

Adapt your script with variables
Task 3

Create a Matlab function
Task 4

EXxercise...



EEGLAB

Edlit Plot 5t

Tools

Memory options

NS

NS

Import data
Import epoch info
Import event info

Xport

<SS

<

Load existing dataset

Save current dataset(s)

Sawe current dataset as

Clear dataset(s)

Ok |

Create study

Load existing study
Save current study
Save current stucly as

Clear study

Save history

Memonry and other options

Change memory options
to allow more than one dataset in memory

Quit




Create a script from ‘eegh’ output

Start by loading a continuous dataset

Edit Tools Plot Study Datasets
Import data ' ot

Import epoch info

Help

File Edit Tools Plot Study Datasets Help

Import event info

v v w

Export

Load existing dataset
Save current dataset(s)
Save current dataset as
Clear dataset(s)
Create study b mcnth |
Load existing study

Save current study

>ampling rate
Save current study as 0f

Clear study

Memory and other options

History scripts 4
Quit

YNTIINUOUS Late



Create a script from ‘eegh’ output

Change sampling rate
Filter the data
Re-reference

Interpolate electrodes

Reject continuous data by eye

=l Extract epochs

Remove baseline

Run ICA

Remove components

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

Locate dipoles using DIPFIT 2.x
Peak detection using EEG toolbox

FMRIB Tools
Locate dipoles using LORETA P

Epoch on Memorize letters

Sternberg: Memorize letters




Create a script from ‘eegh’ output

| EEGLAB v7.27.18 LN .
IOl Study Datasets Help PIOt an Ic ERP Image

Channel locations

Channel data (scroll)
Channel spectra and maps

Channel properties

Channel ERP image
Channel ERPs
ERP map series
Sum/Compare ERPs

Component activations (scroll)

Component spectra and maps _ ] _ -IE- _ 0
Component maps
Component properties
Component ERP image

Component ERPs

Sum/Compare comp. ERPs | T T T T
Data statistics Fregue M

Time-frequency transforms
Cluster datasetICs her ontior




Create a script from ‘eegh’ output

|

File N

W IR

L I I 1 I I
-200 -100 0 100 200 300 400 500
Time (ms)




Retrieve commands from eegh

Write a script to do this:

>> eegh



Retrieve commands from eegh

>> eegh
[ALLEEG EEG CURRENTSET ALLCOM] = eeglab;

EEG = pop loadset('filename', 'stern 125Hz.set');
[ALLEEG EEG CURRENTSET] = eeg store(ALLEEG, EEG, 0);

EEG = pop epoch( EEG, {'B' 'Cc'" 'D' ... }, [-0.2 0.6],
'Memorize epochs', 'epochinfo', 'yes');

[ALLEEG EEG CURRENTSET] = eeg store(ALLEEG, EEG, 1);
EEG = pop rmbase( EEG, [-200 01]);

[ALLEEG EEG] = eeg store(ALLEEG, EEG, CURRENTSET);

figure; pop erpimage(EEG,0, [3],[], Comp.

3',10,1,{},11,"' ', verplabel', , erp', 'on', 'cbar',
‘on', 'topo',{mean(EEG.icawinv(:,[3]),2) EEG.chanlocs EEG

})i

'newname'’

.chaninfo



Create a Matlab script

File Edit Debug Parallel Desktop Window Help

fDﬁH.-quu"iEdm-Unﬁﬂeds 5 |
. Shortcuts (2] Howto Add (2] What'| —

°N MATLAB? Watch this Vid File Edit Text Go Cell Tools Debug Desktop Window Help al|?l X
ew to ? Watch this Video | |- N = =

. NER | $RR20¢ |00 -Meani | R-BXBRE BB | seck(Base v [0 v
- B8 -0 [+ =11 |[x|%&| 0

>> 1 |
>>

>>

>> edit |

4\ Start

| script ln 1 Col 1 |OWR .




Create a Matlab script

Copy and paste from Matlab window:

File Edit Text Go Cell Tools Debug Desktop Window Help ‘¥|?' X
NEd|sMRYe (o2 - Aasf|b-80 80 BB |sud s~ [0
BB -(w [+ #a1 [ x|%%|0

[ALLEEG EEG CURRENTSET ALLCOM] = eeglab: O
EEG = pop_loadset( 'filename', 'stern.set', 'filepath', 'C:\\Users''julie’’Docum

EEG = pop_epoch( EEG, { 'B' 'C' 'D' 'F' 'G' ‘'H' 'J' 'K' 'L' 'M' 'N
[ALLEEG EEG CURRENTSET] = pop_newset (ALLEEG, EEG, 1, 'gui', 'off'):;

EEG = pop_rmbase( EEG, [-200 0]1):

[ALLEEG EEG] = eeg_store (ALLEEG, EEG, CURRENTSET):

figure; pop_erpimage (EEG,0, [3],[],'Comp. 3',10,1,{},[],'' , 'verplabel',6'',6 'er—

W 3 M ;s WM -

Save as ‘ploterpimage.m’

In MATLAB folder

»
Ln 7 Col 51 OVR .:




Run your new script

File Edit Debug Parallel Desktop Window Help

DS sB9 0o (YA |

C:\Users\julie\Documents\MATLAB

Shortcuts (2] How to Add (2] What's New

o New to MATLAB? Watch this Video, see Demos, or read Getting Started.

ey
>

>

>

>

>> edit

>> ploterpimage

|4Start|




Exercise page 1

>> eeglab

% load dataset stern 125hz.set in data folder
% epoch on 'memorize letter' B, C, etc...
% plot erpimage for component 3

>> eegh
% open Matlab editor
>> edit

% copy & paste eegh results into a new
% file and save it (ploterpimage.m)

>> clear

>> close all

>> ploterpimage
>> eeglab redraw



Advanced Scripting in EEGLAB



STUDY scripts

C)<)<]

Most important option:

< [<]

* Allows only one dataset
to be loaded at once.

<]

* Most STUDYs are too big to
have all data loaded at once.

% Set memory options:

pop_editoptions( 'option storedisk' '



Edit dataset info

8 non Create a new STUDY set -~ pop_studyl)
Edit STUDY set imormation - remember to save changes
®nn EEGLAB v13,x dev e ——
BN (ot Tools Plot Study Datasets Melp STUDY sat task name:
mport data " STUDY sat notes:
och info >
mMport event inf » y
> dataset fiename browse subject  session  conditon Proup Selactby r.v.
| MUsersamotempSTUDYSDY, 01 igrore Komp.:1 2. |Clear]
a0 #xsting dat —  pm—
Save current datasen(s) = B AusersamotempSTUDYS0Y, | - S01 Memorze Comp.:1 2.0  Clear |
Save current dataset as ::::: 3  MUsersamotempSTUDYED, | - 501 Probe Comp..1 2..; |Cloar |
Clear datasets) :
4 = { ) \Cloar |
g all jar -
‘ { ) Clear |
T Browse for datasets - :
Load existing study Simple ERP STUDY 6 | J .CMJ
Sawve current study : L ) (Clear]
Save current study as , —
Clear study 8 L ) \Clear |
Memary and aother options 9 A )\ )
0 { ) \Clear)
History scripts >
Manage plugins > Imporsant not: Remaved dessnts wil ~ol be saved Sekoce beng duliec kom EEGLAB memary
Quit L<) Pager | > |
Damsat info jconditon, group, ..} diflars bom sudy inko. [sef] » Ovenarite dataset info for each dataset on disk
_ Dekie dusker informaton (0 aliow loading new datasats, sel new components for chustering, aic)
[__Heip | [ canesl | | O« |

[STUDY ALLEEG] = std editset( STUDY, ALLEEG, 'name', 'Stenberg', 'commands', {{'index' 1
'load' '/data/STUDY/SO0l/Ignore.set'} {'index' 2 'load' '/data/S0l/Memorize.set'} {'index'
3 'load' '/data/S0l/Probe.set'} {'index' 1 'subject' 'S0l1'} {'index' 2 'subject' 'S01'}
{'index' 3 'subject' 'S01'} {'index' 1 'condition' 'Ignore'} {'index' 2 'condition'
'"Memorize'} {'index' 3 'condition' 'Probe'}}, 'updatedat',k 'off' );



Looking a the function that create STUDY

[STUDY ALLEEG] = std_editset( STUDY, ALLEEG, 'name','Stenberg', 'commands',

{{'index' 1 'load' '/data/STUDY/SO0l/Ignore.set'} ..

{'index' 2 'load' '/data/S0l/Memorize.set'} ..
{'index' 3 'load' '/data/S0l/Probe.set'} ..

{'index' 1 'subject' 'S01'} ..

{'index’ 2 'subject' 'S01'} ..

{'index’ 3 'subject' 'S01'} ..

{'index' 1 'condition' 'Ignore'} ..

{'index' 2 'condition' 'Memorize'} ..

{'index' 3 'condition' 'Probe'l}}, 'updatedat', 'off' );

[STUDY ALLEEG] = std_editset( STUDY, ALLEEG, 'name', 'Stenberg', 'commands',

{{'index' 1 'load' '/data/STUDY/S0l/Ignore.set’ 'subject' 'S0l' 'condition' 'Ignore'} ..
{'index' 2 'load' '/data/S0l/Memorize.set’ 'subject' 'S0l' 'condition' 'Memorize'} ..
{'index' 3 'load' '/data/S0l/Probe.set’ 'subject' 'S0l' 'condition' 'Probe'} ..

}, 'updatedat', 'off' );

35



EXxercice

[STUDY ALLEEG] = std_editset( STUDY, ALLEEG, 'name','Stenberg', 'commands',
{{'index' 1 'load' '/data/STUDY/S0l/Ignore.set’ 'subject' 'S0l’ 'condition' 'Ignore'} ..
{'index' 2 'load' '/data/S0l/Memorize.set’ 'subject' 'S0l’ 'condition' 'Memorize'} ..
{'index' 3 'load' '/data/S0l/Probe.set’ 'subject' 'S0l’ 'condition' 'Probe'} ..

}, 'updatedat', 'off' ); \ Y |

If not present, add it by hand because
some dataset might not have it

1- Start EEGLAB and import the 3 datasets for Subject 1 (Ignore.set, Memorize.set
and Probe.set) in a STUDY (menu Tools > Create STUDY > Browse for datasets)

2- Look in the history (type eegh)
3- Copy to a script, add “eeglab redraw” at the end of your script

4- Restart Matlab, execute the script, look at your STUDY info and design (menu
STUDY > Edit STUDY info and STUDY > Select/Edit STUDY design)

5- Modify the script to import subject 1 to 4

6- Restart Matlab, execute the script, look at your STUDY info and design 36



Redefining events

Adjusting latencies

for iEvent = l:length(EEG.event)
% shift by 16 samples (or 53.3ms at 200Hz) due to filter delay

(]

EEG.event (iEvent).latency = EEG.event(iEvent).latency + 16;

end;
EEG.saved = 'no';
[ALLEEG EEG CURRENTSET] = eeg store(ALLEEG, EEG);

eeglab redraw



EEGLAB v14.x [dav)

ol -
File m Tools Plot Study Datasets

— Dataset info

Help

Event fields

Event values
About this dataset
Channel locations

R

Select data
Select data using events
Select epochs or events
Copy current dataset

Append datasets
Delete dataset(s) from memory

tdit events & mark bad channels

P

Renaming events
iDat = l:length(ALLEEG)

for

end;

EEG = ALLEEG(iDat);
$ rename events

o

EEG = pop selectevent( EEG,
EEG = pop selectevent( EEG,
EEG = pop selectevent( EEG,
EEG = pop selectevent( EEG,
EEG = pop selectevent( EEG,

EEG.saved = 'no';

@ [} Seleot events - pop_selectevenn)

Field Selection Set=NOT
latency (ms) No description min max

oo No description 1

eooch No dascrighion

Event indices

Event selection

Selact al events NOT selected above {Sat this buson and "al BUT" busons |...
Koep only selachd everts and remove sl ofar svents

Rename selocted event type(s) as tpe: A

Raten ol evant ype samels) in (oew)

Epoch selection
. Remaove epochs not rakerenced by any selected avant

nvert spoch selecion

Help Cancel

'type',1, 'renametype', 'A', 'deleteevents', 'off');
'type',2, 'renametype', 'B', 'deleteevents', 'off');
'type', 3, 'renametype', 'C', 'deleteevents', 'off');
'type',4, 'renametype', 'D', 'deleteevents', 'off');
'type', 8, 'renametype', 'rt', 'deleteevents’', 'off');

[ALLEEG EEG CURRENTSET] = eeg store(ALLEEG, EEG, iDat);

eeglab redraw
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Redefining events

for iDat = l:length(ALLEEG)
TMPEEG = eeg checkset(ALLEEG(iDat), 'loaddata'); % load data

$ 'B' 'C' 'D' "F' 'G' 'H' g’ 'K' 'L’ ... => Memorize
gB' 'gC' 'gD' 'gF' 'gG' 'gH' 'gJd' 'gK' 'gL' ... -> Ignore
for iEvent = l:length(TMPEEG.event)

prevEvent = TMPEEG.event(iEvent).urevent-2;

if prevEvent > 2 && TMPEEG.urevent(prevEvent).type(l) == 'g'
TMPEEG.event (iEvent) .prevEvent = 'ignore';
else TMPEEG.event(iEvent).prevEvent = 'memorize’;
end;
end;
TMPEEG.saved = 'no'; % tag as not saved
ALLEEG(iDat) = pop_ saveset(TMPEEG, 'savemode', 'resave'); % resave data
end;

STUDY = std maketrialinfo(STUDY, ALLEEG); % update STUDY
STUDY.saved = 'no';
[STUDY EEG] = pop_savestudy( STUDY, EEG, 'savemode', 'resave'); % resave STUDY

Precomputed files need to be recomputed after changing events.
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Load dataset info from commandline

% Create Stern STUDY

[ALLEEG EEG CURRENTSET ALLCOM] = eeglab;

pop_editoptions( 'option_storedisk', 1);

subjects = {'S01' 'S02' 'S03' 'sS04' 's05' 's06' 'sS07' 's08' 's09' 'sS10' 'Sl1l1l' 'sS12'};
filepath = '/Users/arno/temp/STUDY'; % XXXXX Change path here XXXXX

if ~exist(filepath), error('You need to change the path to the STUDY'),; end;

commands = {}; % initialize STUDY dataset list

% Loop through all of the subjects in the study to create the dataset
for loopnum = 1l:length(subjects) %for each subject
IgnoreFile = fullfile(filepath, subjects{loopnum}, 'Ignore.set');
MemorizeFile = fullfile(filepath, subjects{loopnum}, 'Memorize.set');

ProbeFile = fullfile(filepath, subjects{loopnum}, 'Probe.set');
commands = {commands{:}
{'index' 3*loopnum-2 'load' IgnoreFile 'subject' subjects{loopnum} 'condition' 'Ignore'}
{'index' 3*loopnum-1 'load' MemorizeFile 'subject' subjects{loopnum} 'condition' 'Memorize'}
{'index' 3*loopnum 'load' ProbeFile 'subject' subjects{loopnum} 'condition' 'Probe'}};
end;

% Uncomment the line below to select ICA components with less than 15% residual variance
% commands = {commands{:} {'dipselect', 0.15}};
[STUDY, ALLEEG] = std _editset(STUDY, ALLEEG, 'name', 'Sternberg', 'commands', commands, 'updatedat',6 'on');

% Update workspace variables and redraw EEGLAB

CURRENTSTUDY = 1; EEG = ALLEEG; CURRENTSET = [1l:length(EEG)];
[STUDY, ALLEEG] = std_checkset (STUDY, ALLEEG) ;

eeglab redraw



STUDY structure

STUDY =

name:
task:
datasetinfo:
notes:
filename:
filepath:
history:
subject:
group:
session:
condition:
design:

etc:
preclust:
cluster:
changrp:
saved:

'Sternberg!’
'Sternberg!’
[1x39 struct]

'stern.study'

'C:\Users\julie\Documents\Workshops\Finland\STUDY'

[1x7332 char]
{1x13 cell}
{'"}

[]

{'ignore' 'memorize'

[1x1 struct]
[1x1 struct]
[1x1 struct]
[1x1 struct]
[1x71 struct]
lyes\

'probe'}



Understanding STUDY structure

>> STUDY.datasetinfo(ll) % access dataset 11
ans =

filepath: [1x61 char]

filename: 'S04.set'

subject: ('S04" Subject 4!
session: []
condition:
group: v’ >> trialinfo(163) % access trial 163

trialinfo: 1x350 struct ans =

stimtype: ‘Memorize’

latency: 13201

index: 11

comps: [1x24 double]
duration: O



ann  samwson Select subjects

File Edit Tools Plot BI0GWE Datasets Help |

. . Edit STUDY design -- pop_studydesign
__STUDY set: ~_Edit study info eoeo gn -- pop_studydesign(
Select/Edit study design(s)
Study filename: ...s/dazi Precompute channel measures Select STUDY design New | Rename Delete | Design Matrix
Study task name Plot channel measures Comparing conditions
Kb of subjects Memorize-Iignore -- Load ‘
Precompute component measures Probe Only -- Load
Nb of conditions .
i Design 4 .
# of sessions Measure Product clustering > Ignorge+Menorize vs Probe ® @® Add variable
T (2 (TS PCA clustering (original) 2 My design
Epoch consistency Edlt/plot clusters Resave STUDY
Channels per frame Select independent variable
Channel locations . . condition
Clusters 1 — Edit selected desian glqrajion
) - linit_index
Status Pre-clustered |ndependent variables New Import ‘ init_time
e e S Categorical variable: condition - Values (ig :g:gt
pre§_trial
This is a categorical var. a
= i R Select variable values
STUDY = std makedesign (STUDY, ALLEEG, 3, slete al pre-comptited datafies for i eerrs
. ., . memorize
'variablel', 'condition', TS
. ignore & memorize
'vvariable?2' , 1y , Web help

'name', 'Design 3',

'valuesl', {'ignore' 'memorize' 'probe'},
'subjselect',{'S02' 'S03'},
'dataselect',{'condition' {'probe'}}):;

Combine selected values

Cancel Ok




STUDY design structure

_______________________________________________________________________________________________________________________________________________________________

STUDY.design(1)
ans =

name: 'Design 1 - compare letter types'
variable: [1x2 struct]
cases: [1lxl struct]
include: {}
cells: [1x39 struct]

_______________________________________________________________________________________________________________________________________________________________

'

name: 'Design 1 - light and audio all subjects

variable: [1x2 struct]
(1).label : 'condition'

(1).pairing: 'on'

(1).value : {'ignore' 'memorize' 'probe'}
(2).label : "'

(2).pairing: 'off’

(2).value : {}

cases:

[1x1 struct]

label: 'subject'
value: {'S01' 's02' 's03' 's04' 'sS05' 's06'

}
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Precompute data measures

TIP: Compute all measures so you can
test different combinations for clustering

——
'cycles', [3 0.5], ‘nfreqs’, Test

cycles', [3 0.5], 'nfregs’, 100 | Test |

[STUDY ALLEEG] = std precomp (STUDY, ALLEEG, 'components’, 'erp',
'on', 'rmbase',6[-200 0] , 'scalp', 'on', 'spec’, 'on',
'specparams',{}, 'ersp', 'on', 'erspparams’, {'cycles’ [3 0.5]
'nfregs',100, 'freqgs',[3 70] }, 'ite', 'on');



Precluster the data

Eregirange sz
imerange|ms] _'
limerange|msj _| rangehiz| E

imerange|ms] E' grrangeiiz E

[STUDY ALLEEG] = std preclust(STUDY, ALLEEG, 1, {'dipoles’, 'weight',610},
{’moments', 'weight',10});



Cluster components

EEGLABE v6.0b

File ' Tools o

Datasets Help N

Edit study info

Precompute channel measures
Plot channel measures

Precompute component measures

Build preclustering array
Cluster components

Edit/plot clusters

L
3
_ Cancel | Ok |

[STUDY] = pop clust(STUDY, ALLEEG, 'algorithm', 'kmeans', 'clus num',624);



Understanding STUDY structure

26 = # of clusters

>> STUDY.cluster
1x26 | struct array with fields:

parent One cluster:
name i
child >> STUDY.cluster (6) 6 = cluster index
ans =
comps
& parent: {'ParentCluster 1'}
sets
name: 'Cls 6'

algorithm child: []
preclust IC indices comps: [35 7 12 35 10 23 7 30 4 ..]
dipole

: [1234567891012 .
allinds dataset indices for ICs sets: | ]

algorithm: {'Kmeans' [24]}

setinds

preclust: [1x1l struct]
dipole: [1x1 struct]



View and edit current channels -- pop_chanplot() (=)(](x]

Choose
which
channel

Figure 3: Channel ERP
File Edit View Insert Tools Desktop Window Help

Study "

Select channel to plot

lAll FP1
All FP2
All F3
All F4
All C3
All C4

AL O

Plot ERPs

¥

Select subject(s) to plot .
Choose which

cha FP1

cim FP1 SUbJeCt
ega FP1
fsa FP1
gro FP1
Params Plot ERP(s)

Plot channel properties

]
|
|
|
|

_Params |

» DN@gde » ARLO09RW- 3 0B a O
ERP - CZ, ignore ERP - CZ, memorize ERP - CZ, probe I I
2 2 2 |
s
e 0 0 . :
= ave STUDY set to disk [\."hDme,"'l:iell:lrrr‘ue‘."mar\ak:l,e'ann‘nal,"ar' imal. stu
52 2 -2
&£
-4 -4 -4
4000 0 1000 1000 0 1000 -1000 0 1000 Cancel Help Ok |
Time (ms) Time (ms) Time (ms)
STUDY = std_erpplot(STUDY,ALLEEG,'channels',{'FP1"});
Figure 3: Channel ERP Figure 3: Channel ERP
File Edit View Insert Tools Desktop Window Help

File Edit View Insert Tools Desktop Window Help

» DEdde b AKLODEH- S 0B n O

ERP - ignore ERP - memorize

ERP - probe

STUDY = std_erpplot(STUDY,ALLEEG,

'channels',{'FP1’ ... });

STUDY = std_erpplot(STUDY,ALLEEG,'channels' {'FP1"}, 'plotsubjects’, ‘on");

» DNEgde b ALO9EW- @ 0DE a@

Potential {p )

ERP - CZ, ignore ERP - CZ, memorize ERP - CZ, probe

1000 0 1000 -1000 0 1000 -1000 0 1000
Time (ms) Time (ms) Time (ms)



) View and edit current channels -- pop_chanplot() ]_||E||x|
Study "
) i -
Select channel to plot = / Set parameters for plotting ERPs -- pop_erpparams()
All FP1 =
All FP2
All F3 7 300400] | Display fiter in Hz [high]
Al F4 L N =
Al C2 ] Plot conditions on w = same ber2
All C4 I Elotgroups o the same pane!
Plot ERPs

Statistics lparametric v‘ Threshold

[’_‘] Compute condition statistics

Compute grauR statistics

Figure 4: Channel ERP
File Edit View Insert Tools Desktop Window Help

= L’J\ju‘ék\'\i\w?@‘gif'@l]lﬂ O

ERP - Ignore, 200-300ms

Cancel

Time range in ms [low high) Plat limits in u' [lowy high) “
Plot scalp map at latency [ms]
k

Help o]

ERP - Memorize, 200-300ms

ERP - Probe, 200-300ms g2.6

~

|,." home/delormej/matlab/animaljanimal. st

Help Ok |

STUDY = std_erpplot (STUDY,ALLEEG,

'topotime’', [200 300]
[STUDY erpdata ] =

, 'channels',{'0OZ' '0O2' 'FPl1l' 'FPZ'
std_erpplot (STUDY,ALLEEG,

'FP2'});
, ‘topotime’ ,[200 300]

, ‘channels’ ,{’0Z’' ’'02'});

Exporting to excell file

[1x67x13 double] xlswrite('myxlsfile', squeeze (erpdata{l}),1):;

[1x67x13 double] xlswrite('myxlsfile',6 squeeze (erpdata{2}),2);

[1x67x13 double] xlswrite('myxlsfile',6 squeeze (erpdata{3}),3):;
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Exporting text file

-0.137 -0.4 3.7 09 -15 . -0.98 1.8 237 -14  -28 -0.03 3.5
-0.54 -1.3 3.6 -1.1 -1.2 0.62 -0.91 1.6 2.2 -0.98 -7.7  -0.42 3.2
-0.77 -0.06 3.6 -1.4 -1.2  0.78 -091 1.2 2.1 -0.66 -0.76 -1 2.5
-0.61 -0.83 3.7 -1.2 -1.2  0.53 -0.88 1.1 1.7 -1.2 -1.8 -1.2 1.6
-0.34 -0.79 3.7 -0.98 -1.2 0.7 -0.72 1 1.4 -1.7 -2.3 -0.72 1.4
-0.27 -0.42 3.2 -0.69 -1.4 -0.04 -0.29 097 0.81 2.5 -1.5 -0.38 1.7
0.097 -0.58 3.2 -0.61 -1.2 -0.32 0.36 0.47 2.1 -0.96 -2.8  0.89 2.4
0.43 -0.04 2.3 -047 -0.87 -0.37 0.21 0.83 3.1 -0.53 -0.85 1.2 3.4
0.21 -0.54 24 -007 -0.05 -0.08 -0.08 1 3.3 -0.42 -3.7 0.92 3.8
-0.1 -1.1 2.7 -033 -0.28 0.48 -0.5 1.2 3.3 -0.53 -2 0.36 -
-0.51 ~2.2 29 -0.59 -0.23 1.3 -0.72 1.4 3.3 -0.14 -16  -0.05 3.9

dlmwrite ('erpfile. txt',6 squeeze (erpdata{l}), 'delimiter', '\t', 'precision',6 2);

dlmwrite('erpfile.txt',6 squeeze (erpdata{2}),'-append’', 'roffset',K 1,
'delimiter', '\t', 'precision',6 2);

dlmwrite('erpfile.txt',6 squeeze (erpdata{2}),'-append’', 'roffset',K6 1,
'delimiter', '\t', 'precision',6 2);
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STUDY Script

% Create Stern STUDY

[ALLEEG EEG CURRENTSET ALLCOM] = eeglab;

pop_editoptions( 'option storedisk', 1);

subjects = {'S01' 'S02' 'S03' 'sS04' 'sS05' 'sO06' 'sS07' 's08' 'sS09' 'sS10' 'S11l' 'sS12'};
filepath = '/Users/arno/temp/STUDY'; % XXXXX Change path here XXXXX

if ~exist(filepath), error('You need to change the path to the STUDY'); end;

commands = {}; % initialize STUDY dataset list

% Loop through all of the subjects in the study to create the dataset
for loopnum = 1l:length(subjects) %for each subject
IgnoreFile = fullfile(filepath, subjects{loopnum}, 'Ignore.set');

MemorizeFile = fullfile(filepath, subjects{loopnum}, 'Memorize.set');

ProbeFile = fullfile(filepath, subjects{loopnum}, 'Probe.set');

commands = {commands{:}
{'index' 3*loopnum-2 'load' IgnoreFile 'subject' subjects{loopnum} 'condition' 'Ignore'}
{'index' 3*loopnum-1 'load' MemorizeFile 'subject' subjects{loopnum} 'condition' 'Memorize'}
{'index' 3*loopnum 'load' ProbeFile 'subject' subjects{loopnum} 'condition' 'Probe'}};

end;
% Uncomment the line below to select ICA components with less than 15% residual variance

% commands = {commands{:} {'dipselect',6 0.15}};

[STUDY, ALLEEG] = std_editset(STUDY, ALLEEG, 'name', 'Sternberg', 'commands',h commands,'updatedat', 'on');
% Update workspace variables and redraw EEGLAB

CURRENTSTUDY = 1; EEG = ALLEEG; CURRENTSET = [l:length (EEG)];
[STUDY, ALLEEG] = std_checkset (STUDY, ALLEEG) ;

eeglab redraw

[STUDY ALLEEG] = std precomp (STUDY, ALLEEG, {},'rmicacomps','on', 'interp', 'on', 'recompute',6'on',6'erp',6 'on');
STUDY = pop_erpparams (STUDY, 'topotime',[200 300] );
[STUDY erpdata] = std_erpplot(STUDY,ALLEEG,'channels',{'LEYE' 'REYE' 'OZ' 'O2' 'FPl1l' 'FPZ' 'FP2' 'AF7'

'AF3' 'AFZ' 'AF4' 'AF8' 'F9' 'F7' 'F5' 'F3' 'Fl1l' 'FZ' 'F2' 'F4' 'F6' 'F8' 'F1l0' 'FT9'

'FT7' 'FC5' 'FC3' 'FCl' 'FCZ' 'FC2' 'FC4' 'FC6' 'FT8' 'FT10' 'T7' 'C5' 'C3' 'Cl' 'Cz'

'C2' 'C4' 'Cé6' 'T8' 'TP9' 'TP7' 'CP5' 'CP3' 'CP1l' 'CPZ' 'CP2' 'CP4' 'CP6' 'TP8' 'TP10'

'P7' 'P5' 'P3' 'P1' 'PZ' 'P2' 'P4' 'P6' 'P8' 'PO9' 'PO7' 'PO3' 'POZ' 'PO4' 'PO8' 'PO10' '0O1'});

dlmwrite ('erpfile. txt',6 squeeze (erpdata{l}), 'delimiter', '\t', 'precision',6 2);
dlmwrite ('erpfile. txt',6 squeeze (erpdata{2}),'-append', 'roffset', 1, 'delimiter', '\t',6 'precision',6 2);
dlmwrite ('erpfile. txt', squeeze (erpdata{2}),'-append', 'roffset', 1, 'delimiter', '\t',6 'precision',6 2);



Advanced scripting: EEG pipeline

sInfo = [];
sInfo(end+l) .file = 'rawdata/S0l.raw'; «——— Raw data file
sInfo(end) .name = 'S01l'; ¢ Subject name

sInfo(end) .bad channels = { 'El' }; <« Subject name




Advanced scripting: EEG pipeline

sInfo = [];

sInfo(end+l) .file = 'rawdata/S0l.raw'; «——— Raw data file

sInfo(end) .name = 'S01l'; ¢ Subject name

sInfo(end) .bad channels = { 'El' }; <« Subject name

sInfo(end) .bad data = [726 1495;6098 6831;13245 14057;15715 16399;22756 2445’

Copy the output from the eeg_eegrej function in the history



Advanced scripting: EEG pipeline

sInfo = [];
sInfo(end+l) .file = 'rawdata/S0l.raw'; «——— Raw data file

sInfo(end) .name = 'S01l'; ¢ Subject name
sInfo(end) .bad channels = { 'El' }; <« Subject name
sInfo(end) .bad data = [726 1495;6098 6831;13245 14057;15715 16399;22756];

sInfo(end) .bad comps = [1.6681 1.9870 0.3979 0.4444 -0.2274 -0.1433 -0.2626 -
1.1917 -1.4838 0.7469 -1.1599 0.4773 -0.3257 0.3074 -

Copy transposed columns of the inverse weight matrix
EEG.icawinv for your selected artifact components



sInfo = [];

Advanced scripting: EEG pipeline

sInfo(end+1l) .file = 'SO0l.raw'; d . f f1
sInfo(end) .name = 'S01'; atainfo.m file
sInfo(end) .bad channels = { 'El' };

sInfo(end) .bad data = [726 1495;6098 6831;13245 14057;15715 16399;22756 24457;3074°
sInfo(end) .bad comps = [1.6681 1.9870 0.3979 0.4444 -0.2274 -0.1433 -0.2626 -0.108:

1.1917 -1.4838 0.7469 -1.1599 0.4773 -0.3257 0.3074 -0.163!

sInfo(end+1l) .file = 'S02.raw';
sInfo(end) .name = 'S02';
sInfo(end) .bad channels = { };

sInfo(end).
sInfo(end).

bad data = [41661 43713;24000 24833;44878 46501,;48706 49210;51190 52353
bad comps = [0.6960 -0.8637 0.9087 -0.8028 0.4873 -0.2142 0.2737 -0.21
-0.0875 -0.4056 -0.0287 -0.3870 0.0600 -0.3716 0.3425 -0.4:
2.1928 1.5712 0.8622 0.3215 -0.0357 -0.3125 -0.2268 -0.3:

sInfo(end+1l) .file = 'S03.raw’';

sInfo(end) .name = 'S03';

sInfo (end) .bad channels = { 'E10' 'E19' 'E20' 'E29' };

sInfo(end) .bad data = [1 10449;19808 21815;25678 27254;29257 30010,;34023 36016;367:
sInfo(end) .bad comps = [ 1.8583 2.0468 -0.0516 0.3159 -0.4256 -0.2770 -0.3643 -0.:

1.2189 -0.7385 1.2464 -0.8913 0.5475 -0.3971 0.2987 -0.:.
-0.1248 -0.1358 -0.1954 -0.2533 -0.1555 -0.2313 -0.0351 -0.!



datainfo;

pop editoptions( 'option storedisk', 1);

outEﬁtEEGFolder = 'preprgcessed_data';

if ~exist(outputEEGFolder), mkdir (outputEEGFolder); end;

for iSubj = 1l:length(sInfo)

% load dataset
EEG = pop biosig(sInfo(iSubj) .file);
EEG.setname = sInfo(iSubj) .name;

% proprocess data
chanFile= 'plugins/dipfit2.3/standard BEM/elec/standard 1005.elc’;
EEG = pop_chanedit (EEG, 'lookup',6 fullfile(fileparts(which('eeglab.m')), chanFile));

EEG = pop iirfilt( EEG, 0.5, 0, [], O, 0); % high pass filtering

EEG = pop iirfilt( EEG, 0, 55, [], O, 0); % low pass filtering

EEG = pop_select (EEG, 'nochannel', sInfo(iSubj) .bad channels); % remove bad channels
EEG = pop reref( EEG, []); % average reference (optional)

EEG = eeg _eegrej( EEG, sInfo(iSubj) .bad data); % remove bad portions of data

$ run ICA
EEG = pop runica(EEG, 'icatype', 'sobi');

% tag bad components
EEG = pop_ findmatchingrejcomps (EEG, 'matchcomps',6 sInfo(iSubj) .bad comps, 'corrthresh',0.92);

% extract data epochs
EEG = pop epoch(EEG, { 2 4 } , [-1 2]);

% save dataset

EEG.saved = 'no';

EEG = pop_saveset( EEG, 'filepath',6 outputEEGFolder, 'filename', [ sInfo(iSubj) .name '.set' ]
end



|; @® Figure 3: Channel ERP
Create S I UDY File Edit View Insert Tools Desktop Window Help

Ddde W R0 EA-3 0B 7>

datainfo; t
pop_editoptions( 'option storedisk', 1);

outputEEGFolder = 'preprocessed data'; -
studyCommand = {}; >

-14.7

[o)

% generate STUDY commands

for iSubject = 1l:length(sInfo)

fileName = fullfile (outputEEGFolder, [ sInfo(iSubject) .name '.set' ]);

studyCommand = [ studyCommand { 'index' iSubject 'load' fileName 'subject'
sInfo (iSubject) .name } ];

end;

% create data

[STUDY ALLEEG] = std editset( [], [], 'name', 'test', 'commands', studyCommand,
‘updatedat'T'off', 'filename', 'test.study', 'resave', 'on');

STUDY = std makedesign (STUDY, ALLEEG, 1, 'name', 'STUDY.design 1', 'delfiles', 'off',

'defaultdesign', 'off', 'variablel'’, 'type', 'valuesl', {'2' '4"' });

[o)

% update workspace variables and redraw EEGLAB

CURRENTSTUDY = 1; EEG = ALLEEG; CURRENTSET = [l:1length(EEG)];
[STUDY, ALLEEG] = std checkset (STUDY, ALLEEG) ;

eeglab redraw

% precompute and plot data

allchanlocs = eeg mergelocs (ALLEEG.chanlocs) ;

[STUDY ALLEEG] = std precomp (STUDY, ALLEEG, {},'interp',6 'on', 'recompute',6'on',6 'erp', 'on');
STUDY = pop_statparams (STUDY, 'condstats',6 'on', 'singletrials',6 'on',6 'mode', 'fieldtrip',
'fieldtripmethod', 'montecarlo’', 'fieldtripmcorrect', 'cluster');

[STUDY erp] = std _erpplot(STUDY,ALLEEG, 'channels',6 {allchanlocs.labels}, 'topotime', [300 400]);
print results.eps -depsc
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Transparency and complex figures

To export figures for publication, use .eps format (postscript) and edit for
instance with adobe illustrator. Use “set(gcf, renderer’, painter’)”
before exporting complex figures. Note that these cannot handle
transparency and 3-D graphics.

Transparency: Use the “plot2svg” matlab toolbox to export figure for
transparency.



Exercise: build your own pipeline

Suggestion for exercise

© NSO RAE 0N

9.
10.
11.

12.
13.

14.
15.

Load oddball_file.set dataset (in Data folder or on the wiki)

High pass filter at 0.5Hz (menu Tools > Filter)

Re-reference to average ref. (optional) (menu Tools > Re-reference)
Reject bad channels using clean_rawdata

Re-reference to average ref. again (optional)

Run ICA

Run IClabel plugin

Tag artifactual components
[~, ind] = max(EEG.etc.ic_classification.ICLabel.classifications, [], 2);
EEG.reject.gcompreject([find(ind == 2);find(ind == 3)]) = 1;

Epoch data on Oddball (type 4) and Standard (type 2) — save dataset
Create a STUDY with this single file

Compare the ERP for Oddball (type 4) and Standard (type 2) and use
single-trial statistics with cluster correction for multiple comparisons

Build a script that creates the STUDY and perform the same analysis

Save the figure at the end of the script in eps or jpg format (“print —depsc
file” command or “print —djpg file” command).

Run the full pipeline (dataset processing and STUDY processing)
Change the filtering in the pipeline (step 2) and observe effects 61



Evaluation of Artifact Subspace Reconstruction
for Automatic EEG Artifact Removal

Chi-Yuan Chang, Student Member, IEEE,

Sheng-Hsiou Hsu, Student Member, IEEE,

Luca Pion-Tonachini, Student Member, IEEE, and Tzyy-Ping Jung, Fellow, IEEE

Abstract— One of the greatest challenges that hinder the de-
coding and application of electroencephalography (EEG) is that
EEG recordings almost always contain artifacts — non-brain
signals. Among existing automatic artifact-removal methods,
artifact subspace reconstruction (ASR) is an online and real-
time capable, component-based method that can effectively
remove transient or large-amplitude artifacts. However, the
effectiveness of ASR and the optimal choice of its parameter
have not been evaluated and reported, especially on real EEG
data. This study systematically validates ASR on ten EEG
recordings in a simulated driving experiment. Independent
component analysis (ICA) is applied to separate artifacts from
brain signals to allow a quantitative assessment of ASR’s effec-
tiveness in removing various types of artifacts and preserving
brain activities. Empirical results show that the optimal ASR
parameter is between 10 and 100, which is small enough to
remove activities from artifacts and eye-related components and
large enough to retain signals from brain-related components.
With the appropriate choice of the parameter, ASR can be a
powerful and automatic artifact removal approach for offline
data analysis or online real-time EEG applications such as
clinical monitoring and brain-computer interfaces.

identify and reject the artifact-related independent compo-
nents (ICs) [7]. However, the ICA-based methods were less
effective in removing transient, non-biological artifacts such
as abrupt impedance changes due to headset motions and
were computationally expensive and generally for offline
analyses.

To address the challenges, Kothe and Jung [8] proposed
the artifact subspace reconstruction (ASR) approach, which
is an automatic, online-capable, component-based artifact
removal method that could be useful in removing transient or
large-amplitude artifacts. ASR is similar to principal compo-
nent analysis (PCA)-based method in which large-variance
components are rejected and channel data are reconstructed
from remaining components. The main difference is that
ASR automatically identifies and utilizes clean portions of
data to determine thresholds for rejecting components. Al-
though recent studies [1] [9] have indicated the potential use
of ASR as a powerful data-cleaning method, the effectiveness
of ASR and the guidelines for choosing its parameter have
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Automated pipeline

oo

Required plugins
- BIOSIG plugin
IClabel plugin
- clean rawdata plugin
firfilt plugin

o0 oe

o0 o

clear
filepath = '/Users/arno/Desktop/EEGLAB-workshop/EEG data/';

% preprocessing

[ALLEEG EEG CURRENTSET ALLCOM] = eeglab;

EEG = pop biosig(fullfile(filepath, 'oddball file.bdf'));

p = fileparts(which('eeglab'));

EEG = pop_chanedit(EEG, 'lookup',fullfile(p, 'plugins/dipfit2.4/standard BESA/standard-10-5-cap385.elp'));

% filter
EEG = pop eegfiltnew(EEG, [],0.5,1690,1,[]1,0);
EEG = pop_reref( EEG, []);

% clean using ASR
EEG = clean_rawdata(EEG, 5, [0.25 0.75], 0.8, 4, 5, 0.5);
EEG pop_reref( EEG, []);

% ICA and labeling

EEG = pop_runica(EEG, 'icatype', 'runica');

EEG = eeg_checkset (EEG);

EEG pop_iclabel (EEG);

[~, ind] = max(EEG.etc.ic _classification.ICLabel.classifications, [], 2);
EEG.reject.gcompreject([find(ind == 2);find(ind == 3)]) = 1;

% extract epoch and save

EEG = pop_epoch( EEG, { '1' '2' }, [-1 2], 'newname', 'Simple Oddball epochs', 'epochinfo', ‘'yes');
EEG pop_rmbase( EEG, [-1000 0] ,[1,[1);

EEG pop_saveset( EEG, 'filename', 'oddball epochs.set','filepath',filepath);

% create study and plot
[STUDY ALLEEG] = std editset( STUDY, [], 'commands',{{'index' 1 'load' fullfile(filepath, 'oddball epochs.set') ...
'subject' 'S01'}}, 'updatedat','on', 'rmclust’','on' );

[STUDY ALLEEG] = std precomp(STUDY, ALLEEG, {}, 'savetrials', 'on', 'rmicacomps','on','interp','on', 'recompute','on','erp','on');

STUDY = pop_erpparams(STUDY, 'topotime',100);

STUDY = std erpplot(STUDY,ALLEEG, 'channels',{'Fpl' 'AF7' 'AF3' 'F1' 'F3' 'F5' 'F7' 'FT7' 'FC5' 'FC3' 'FCl' 'Cl' 'C3' 'C5' ...
‘t7* 'TP7' 'CP5' 'CcP3' 'cpPl1' 'P1' 'P3' 'P5' 'P7' 'PO7' 'PO3' 'Ol' 'Iz' 'Oz' 'POz' 'Pz' 'CPz' 'Fpz' 'Fp2' 'AF8' 'AF4' ...
'AFz' 'Fz' 'F2' 'F4' 'F6' 'F8' 'FT8' 'FC6' 'FC4' 'FC2' 'FCz' 'Cz' 'C4' 'C6' 'TP8' 'CP6' 'CP4' 'CP2' 'P2' 'P4' 'P6' 'P8' ...
'P10" 'PO8' 'PO4' '0O2'}, 'design', 1); 63



